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LB-AC Series Automatic Load Banks 

User Manual 

1 Important Safety Instructions 

● Please read the manual before and reference during use of the product 

● The load bank should be kept and used in a clean, safe environment. This entails that 

the product should be AWAY from environments such as high corrosive, acidic alkaline, 

combustible, and explosive objects 

● Make sure the area is clean and well-ventilated INDOORS. No obstructions are 

allowed within 3-5 meters of the device. If outdoor operation is necessary, avoid having 

the unit in sunlight, rain, wind, and any other adverse conditions 

● Connect all cables correctly. This includes properly installing the ground terminal. 

Power on the system only when all cables are properly secured 

● Risk of electric shock, do not touch the elements inside the machine when powered on. 

● In order to avoid overheating damage, electrical fan is required to continue running for 

3-5 more minutes after load testing. 

 

 

2 Product Overview 

2.1 Introduction 

Thank you for purchasing the LB-AC Automatic Load Bank from Eagle Eye Power 

Solutions! Our systems will accurately test output power and load capacity with all kinds 

of generators and generator sets, for each main electrical parameter including the 

dynamic parameters tested. The following manual will describe the operation and 

performance features of the LB-AC Series. If you have any questions or comment, 

please contact us. 
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2.2 Supply List 

The following table lists the accessories provided with standard purchase. 

 

Items Quantity Remarks 

LB- AC Automatic Load Bank 1  

Power Cord 2 
3 meters (1 set 110V, 

1set 220V) 

RS485 Cable 1 10 meters 

RS485/RS232/USB Converter 1  

 

 

 

 

2.3 Technical Parameters 

 

System Parameters 

Load Voltage 208, 240, 380, 400, 415, 440, or 480 V 

Load Power 10, 30, 40, 50, 100, 200, 300, 500, 800, or 1000 kW 

Frequency 50/60 or 400 Hz 

Wiring Options Single Phase / 3 Phase 3 Wire / 3 Phase 4 Wire 

Power Factor 1 

Load Tolerance 

(each step) 
±5% 

Load Tolerance 

(overall) 
±3% 

Control Power 110/220 VAC single phase, 50/ 60 Hz 

Wire Connection 
Load bank input: 

300kW: busbar at load bank 

200kW: terminal block for indoor type (compact type),  
busbar for outdoor type. 

100kW: terminal block for indoor type (compact type),  
busbar for outdoor type. 

 

Control power input: 
300kW: terminal block 

200kW: 3-pin plug for indoor type (compact type),  
terminal block for outdoor type. 

100kW: 3-pin plug for indoor type (compact type),  
3-pin plug for outdoor type. 

Communication 

Interface 
RS232/ RS485 

Insulation F 

Working Mode Continuous Working 

Cooling Forced air, horizontal air intake and cooling 

Transportation Has lifting eyes and wheel castors 
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Operating Environment Parameters 

Ambient 

Temperature 
-10℃ ～ +50℃ 

Relative Humidity ≤ 95% 

Atmospheric 

Pressure 
86 ～ 106kPa 

Brands of Main Components 

Contactor Schneider 

Fuse MIRO 

PLC Siemens 

Multi-function Meter QINGZHI (Model 3432B) 
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2.4 Available Load Steps (Model Specific) 

 

Available Load Steps (at rated voltage) 

LB-10kW 4 Steps – 1, 2, 2, and 5 kW 

LB-30kW 6 Steps – 1, 2, 2, 5, 10, and 10 kW 

LB-40kW 6 Steps – 1, 2, 2, 5, 10, and 20 kW 

LB-50kW 7 Steps – 1, 2, 2, 5, 10, 10, and 20 kW 

LB-100kW 8 Steps – 1, 2, 2, 5, 10, 10, 20, and 50 kW 

LB-200kW 7 Steps – 5, 5, 10, 10, 20, 50, and 100 kW 

LB-300kW 8 Steps – 5, 5, 10, 10, 20, 50, 100, and 100 kW 

LB-500kW 9 Steps – 5, 5, 10, 10, 20, 50, 100, 100, and 200 kW 

LB-800kW 10 Steps – 5, 5, 10, 10, 20, 50, 100, 200, 200, and 200 kW 

LB-1000kW 11 Steps – 5, 5, 10, 10, 20, 50, 100, 200, 200, 200, and 200 kW 

 
2.5 Measuring Control Function 

Load testing: Can provide load power up to the model’s rated power, test and display 

stable state 3 phase voltage, current, active power, frequency, and working time of 

generator sets. 

Load/unload with one key: Whether manual control or software control, user can preset 

the power, then press load master button. Loading is according to preset power to avoid 

load fluctuation during the power changing. 

Control Pattern: User can choose between local control and intelligent control. 

Local control: There is a local control panel with several power steps available; user can 

load/unload as necessary by these buttons. 

Intelligent control: Through PC software, user can set automatic loads and display, 

record, and manage testing data. User can also form curves, tables, and print reports. 

Local meter display data: Displays 3 phase voltage, current, active power, frequency, etc. 

 

2.6 Software Function 

Communication pattern: The intelligent control uses a photoelectric isolated RS485 

interface connected to PC with anti-interference technology to make system control 

stable. Users can also use USB or RS232 through a converter. 

Load pattern: Manual Load or Automatic Load. 

Manual Load: System will load according to preset power. 
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Automatic load: User can preset power and length of operation time for several load 

periods. 

Parallel testing: When load banks are used in parallel users can control the parallel test 

using the software. User can display and record parameters of each load bank and 

system parameters. 

Real-time parameter: Through the software you can display voltage, current, power, 

power factor, frequency, and time. 

Security monitoring and control: Monitor working state of the load bank by watching 

software light. When there is abnormal occurrence, the load will stop and protect from 

damage. Stop reason will be shown. 

Data collection interval: The minimum data storage interval is two seconds. 

Data save and query: Test data is saved in the software which can be accessed in the 

testing data history. 

Graphical display: View and print real-time or historical testing data curves and graphs 

as follows: 

1) Graphs of real-time voltage, current, frequency and power 

2) Voltage graph 

3) Current graph 

4) Power graph 

5) Frequency graph 

6) Power factor graph 

Data format: All curves and graphs can be outputted as ‘.doc’ format. Testing data can be 

outputted as ‘.xls’ format and can be printed. 

2.7 Protection 

Emergency stop: User can press the Emergency Stop switch in the panel and the load 

bank will stop supplying current. When locked in this state the load/unload button cannot 

be used. 

Overvoltage protection: When input voltage is over the safe value, the load automatically 

stops and gives an alarm. 

Short circuit protection: When short circuit occurs, fuses in the load bank insure load 

stops automatically. 
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Overheating protection: When temperature is over the safe value, it can unload 

automatically and give an alarm. 

Fan interlock protection: When the fan is powered off, the load bank will not supply load. 

Protection Buttons: There are buttons for some protection, when misinformation occurs 

or user has special needs, user can temporarily turn off the corresponding protection 

function to continue working. 

When the control power cable is connected in incorrect phase sequence, the 3-phase fan 

can still work in good condition. 

 
 
 
 
 

 

3 Appearance 

3.1 Overall Appearance* 
 

 

 
*Load Bank size and appearance varies based on specific model. 

 

3.2 Inspection 

(1) Ventilation system: Verify all vents are operating without any obstructions. 

(2) Switch interface: Check all switches and interfaces to ensure that the protection 

switches are turned on and that there are no visible dangers with powering on. 



7 
 

(3) Working conditions: Verify power supply, environment, and equipment is ready to 

handle the load bank current. 

 

3.3 Wiring Installation 

(1) Ground: Connect one end of Earth grounding wire to ground terminal of load bank 

and the other end to the work site grounding system. 

(2) Test Cable: Connect the load cabinet wiring compartment load power input terminal 

to output terminals of generator under test. Connect the end marked with a yellow sign to 

input terminal phase L1, the other end to the output terminal of the device under test 

phase L1. Connect phase L2 to green cable, L3 to red, and blue (or black) cable to N 

phase. 

(3) Power Lines: Connect one end of power line to power terminal of load bank, the other 

end to power supply of 3 phase 50/60Hz at the rated voltage. The blue (or black) color 

cable should be connected to null line (N) of power supply and load bank. And the yellow 

color cable is connected to phase L1 of power supply and load bank; green cable to 

phase L2, red cable to phase L3. Please make sure all the connections are correct and 

tight before operating the system. 

(4) Data Transmission Lines: Connect one end of the data transmission line to the 

RS485 or RS232 interface on the LB-AC load bank. Connect the other end to a PC to 

allow for communication through the software. 

 

4 Local Control 

4.1 Control Panel 

(1) Measuring meter: Displays testing data. 

(2) Fault indicator: In an alarm event, the red fault indicator lights up and the load bank 

protection is active. 

(3) Control mode selector: [Local] switch on for manual operation or switch to 

[Intelligent] to operate via PC software. Two methods are mutually exclusive modes of 

operation; please make sure the current operation mode is in accordance with the 

corresponding mode. 

(4) Fan power supply: Push to power on the fans (light will turn on). 
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(5) Load/Unload: Master load switch, press to power on (light will turn on) and load bank 

will load/unload according to preset power loading. 

(6) Emergency Stop: In case of an emergency, press this switch to immediately stop all 

loading. After resolving the issue, user may rotate the rotary switch clockwise to unlock 

and resume loading. 

(7) Power setting switches: Rating specific switches used to increase the load at 

various increments, press the desired combination of switches to reach the total load 

power needed, and press the < Load/Unload > to confirm and turn on. 

 
 
 
 

 

4.2 Start 

(1) Start the device to be tested: After all cables are properly connected turn on power 

to the device ready for testing. 

(2) Start the machine: Flip power switch on to turn on the machine. The unit can be 

operated by either the control panel or PC. 

(3) Start PC: For intelligent control, connect to PC and open the supporting data 

management software on your computer. 

4.3 Select Control 

(1) Local control: The unit can switch between 2 kinds of operation by the < Control 

Mode > in the control panel. When the switch is set to [Local], please use the control 

panel to operate the machine. 

(2) Intelligent Control: When the switch is set to [Intelligent] use the software to 

control the machine. 

(3) Control interlock: If the unit is not responding, it may be due to two interlocking 

control settings, check whether the control mode is set correctly on both the unit and the 

software. The rest of this chapter focuses on the local control method. 

 

4.4 Load 

(1) Start: Select local control mode and press < Fan Power Supply > on the panel to 

start the fans. Please ensure the fan is working normally before proceeding. 
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Attention: before starting fan, please make sure the dust cover on top of enclosure is 

removed. 

(2) Load: Calculate the total power which needs to be loaded, then press and combine 

the power values needed (they will light up when pressed). Then push the 

<Load/Unload > switch. The yellow indicator lights up and the machine loads in 

accordance with the appropriate power level. 

Example: Suppose you want to load 15 kW total. Press the control panel on the 5 kW & 

10 kW switches to get to 15kW. Then press the <Load/Unload> switch. 

If you need to change the loading power, please press the power setting switches 

accordingly. You may re-combine load profile and press < Load/Unload > to begin 

again. 

Attention: To protect the system, please make sure any new load is not less than 70% of 

the existing load. 

(3) Stop: If you need to end the test, press < Load/Unload > and remove the entire load 

via the power setting switches. 

4.5 Data Display 

(1) Meter Symbol Description: In the loading process, the machine can display real- 

time parameters by measuring instruments. Display instrument operating diagram is 

shown as follows: 
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Instrument has the upper, middle, and lower three display windows. Each value and unit 

symbol form the data. For example, the upper window shows 100.0V, it is to say phase A 

voltage is 100V. 

F1, F2 and on the bottom are to switch three windows and recycling display parameters. 

Symbols meaning: 

V: phase voltage symbol; Unit: V combined with K or M = kV MeV 

V LL two symbols denote a line voltage; Unit: V, and combined with K, M to kV MV; 

A: Current Symbol; Unit: A, and combined with K, M to kA, MA; 

W: active power symbol; Unit: W, and combined with K, M to kW, MW; 

Var: reactive power symbol; unit: Var, and combined with K, M to kVar, MVar; 

VA: Apparent power symbol; Unit: VA, and K, M combination kVA, MVA; 

Hz: Frequency Symbol; Unit: Hertz; 

PF: Power Factor symbol; 

E: energy symbols; Unit: Ep (active power) kWh, Eq (reactive energy) kVAh, Es 

(apparent power) kVA; 

3P3L: 3-phase 3-wire two components; 

3V3A: 3-phase 3-wire three elements; 

3P4L: three-phase four-wire; 

(2) Display the voltage & current: In the non-setting state press F2. Current and voltage 

will be displayed. For example, in the 01 interface (see the following pictures), press the 

F2 key to switch to 02 interface. When in 03 interface press the F2 key to return to 01 

interface. Switch the display process shown below: 
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01: Displays three phase voltages, from top to bottom is A, B, C phase voltage wiring in 

only 3P4L; 

02: Display of three-phase line voltage, from top to bottom as AB, BC, CA line voltage. 

03: Display of three-phase current, from top to bottom as A, B, C-phase current. 

(3). Display the power, frequency, power factor, and electric energy: in the non-set 

state, by pressing F1 and > button, you can view the following parameters. For example, 

in the corresponding interface 04, such as by > key to display 05 interfaces; such as 

pressing the F1 key, the display screens 08. The display switch process is shown below: 



12 
 

 

04: From top to bottom display the total active power, total reactive power, total apparent 

power, display units are watts, var, VA, and with k combined into kw, kvar, kVA, and with 

M combined into MW, Mvar, MVA; 

05: Three-phase active power display, from top to bottom as A, B, C-phase power, 

display units in watts, and with k, M combined into kilowatts, megawatts; 

06: Three-phase reactive power display, from top to bottom as A, B, C phase reactive, 

lack of display units, and with k, M combination into kvar, Mvar; 

07: Display of three-phase apparent power, from top to bottom as A, B, C phase 

apparent power, display units VA and with k, M combined into KVA, MVA; 

08: From top to bottom display voltage and frequency, the total power factor, frequency 

is displayed in Hertz; 

09: Display of three-phase power factor, from top to bottom as A, B, C-phase power 

factor; 

10: Shows the total active energy, the first line shows the symbol Ep, second and third 

lines are combined into 8 data show power, display unit’s kWh; 

11: Shows the total reactive energy, the first line shows the symbol Eq, second and third 

lines are combined into eight data show power when the unit kvar display; 
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12: Shows the total apparent energy, the first line shows the symbol ES, second, a 

combination of three lines into eight data show power when the unit kVA displayed. 

 
Note: In addition to the above features, do not perform other operations on the 

measuring meter. Incorrect settings can result with inaccurate data. If the meter does not 

work properly or shows inaccurate data, please contact Eagle Eye Power Solutions 

 

4.6 Protection 

(1) Emergency Manual: If an emergency happens, please immediately press the red 

[EMERGENCY STOP] switch. The machine will remove the load. Emergency indicator 

lights up and beeps alarm. In this state the load function is locked out and only the fan 

continues to run. After an emergency is corrected, the emergency stop switch can be 

rotated clockwise to unlock for testing to resume. 

(2) Automatic protection: This machine has an automatic protection function. When the 

following circumstances occur the fault and the corresponding alarm indicator lights and 

alarm engage. Protection status loading function is locked. Identify the reasons for 

troubleshooting and once resolved release and re-test the alarm. 

Overheating: The internal temperature exceeds a preset warning level; 

Overvoltage: The machine input voltage exceeds a preset warning level; 

Some of the protective functions have a switch, and when the protection switches point 

downward, it can safely give alarm. When the protective functions give false alarms, or 

require temporary removal of some protection functions, then pull up on the appropriate 

protection switch to turn off protection. Then under the same condition, unit will not give 

the corresponding alarm and instead continues load testing. 

Attention: If there are no special needs for testing, be sure to keep the protection 

switches in downward position so that protection is active. 

 
4.7 Shutdown 

Let fans continue running for about 3 - 5 minutes to disperse the heat inside the chassis. 

Then turn off the power switch on the control panel to stop the fan. Finally, turn off the 
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machine by switching the chassis power switch (located on the side) downward. Once 

the machine is shutdown, remove power supply, testing cables, and any other cables. 

 

5 Data Management Software 

 
5.1 System Configuration 

In this chapter description, [ ] contents quote menu item or option; “” contents quote the 

screen prompts. 

Intelligent control with data management software is accomplished by flipping the 

selector switch to intelligent. The recommended configuration to run data management 

software is: 

◆ Microsoft Windows 98/2000/ XP/Vista/7/8/10 Operating system 

◆ Display Resolution of 1280 × 960 or more 

◆ CPU clocked at 300MHz or more 

◆ 64M RAM or above 

◆ 50M or higher hard drive 

◆ Keyboard, mouse or compatible input device 

◆ Color or black and white printer 

Installation files of the data management software are found on the Eagle Eye USB flash 

drive. 
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5.2 Main Interface 
 

 

Title Bar: Displays the host name and test information tips. 

Menu bar: Contains the main operations. Click the drop-down menus to see sub menu 

options. 

Toolbar: Contains the shortcut keys. Using the mouse, hover over the icon to display the 

function description. 

When the "alarm indicator" is under normal load conditions the light will be green. If the 

light becomes red, this would indicate an abnormal load down, and in a protected state. 

Hover your mouse over the lights to view the protection reasons. 

Comment Field: Used for information tips of shortcut keys, task detail tips, and other 

information. 

 
5.3 Communication Settings 

After the PC is connected to the unit by data transmission line, the first step is selecting 

communication settings. Click the [Settings] menu, and then click the drop-down menu 

in the [Communication Settings] options or click icon on the toolbar. After selecting the 

appropriate communication interface (COM1-COM20) in the dialog box, click OK. Match 

the COM ports assigned by the PC. You can look for available port on your PC in the 

Device Manager (My Computer > Properties > Hardware > Device Manager > Ports). 
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5.4 Loading 

(1) To start the fan: Click the [Shift Control] on [Control] menu, or click the icon on the 

toolbar into sub-file control interface, power setting and loading. Before loading, first click 

[start fan]. 

(2) Loading: The software has two loading modes: manual loading and automatic 

loading. 

(3) Manual load: Can load a single power value, do not select load period in left side, 

and directly select the power value on the right side, then click [Load] or [Unload]. If you 

want to change the power value, just re-select the power and click [Load] or [Unload]. 

(4) Automatic loading: You can set the power and duration of each stage sequentially 

for continuous loading. After clicking [Power Distribution], < Active Power > column to 

set load power, < Power Factor > to set power factor, please then click [OK] and the 

machine will automatically assign load power values. It’s also OK to input load power in 

25% and other periods. 

Then click [Interval], set the duration of each stage, click [Auto load] and it is 

automatically loaded. The system will automatically load 25%, 50%, 75%, 100% or 110%, 

100%, 75%, 50%, 25% of the sequence, and the power change is completed. 

(5) Unload: Click [Unload] to remove the full load. Please keep the fans running 3-5 

minutes after unloading so that standby heat dissipates, then click [End Task] to stop 

the fan. 
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5.5 Real-time data 

(1) Real-time interface: In the loading process, click [Online] menu option immediately 

or click directly on the icon on the toolbar. You can use this window to view real-time 

information during a test. Click the middle of the label; you can switch the display to voltage, 

current, power, frequency, or power factor curve. 

(2) Save Data: Before starting loading, the user can set up to save the forthcoming test. 

Choose the appropriate "interval", then press [Save Real Data] to the right of the Real 

Data window shown, the button changes to [Stop Save], and the program will start 

saving this real-time data of the test. After the test is complete, click [Stop Save] to stop 

and save the test data stored within this period. Then from the [File] menu select [Open 

Test Data] in the test record to view previously saved historical data. 

 

5.6 Test records 

(1) Open Test Data: Click the [File] menu, then click the drop-down menu and select 

[Open Test Data] or click the icon on the toolbar, the following window appears. Test 

data is stored in this interface; you can open any one existing test record and view a 

variety of graphs and reports for the test. 
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Open: Double-click the test records or choose test records and click [Open] button to 

open them. The following analysis of the data, print and other operations are based on 

saved data records from the test. 

Delete: To delete the selected record, click the [Delete] button and confirm. To avoid 

accidental deletion, please back up important data files. 

Import Records: Click [Import] button, then select the recording which you want to 

import in the dialog box and click OK. 

Export Records: Select the record which you want to export, click [Export], confirm the 

message, and in the "Save As" dialog box, click the subsequent [Save]. 

(2) View charts: Click the [Data] menu, and then click the drop-down menu for each 

option, you can choose to view voltage, current, frequency, power, power factor graphs 

and tabular/form data. In the Form Data window, click [Export to Excel] to save the data 

as an Excel document. 
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(3) Report Epitomize: Click [File], then click the [Report epitomize], fill the test 

information as desired, then fill in any comments in the test result window, as reference. 

This page will be printed in the report. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

(4) Parameter List: Click [Set] in the toolbar and select [Modify Parameters], enter the 

correct data, then click [OK], This page will be printed in the report. 

 
 
 
 
 
 
 
 
 
 

 
(5) Print Report: Click [File] then select the option [Print Report], fill in the test 

information, then fill in any comments in the test result window, as reference. This page 

will be printed in the report. 
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5.7 Exit the System 

Click the [File] menu, select the drop-down menu [Exit] option, or click the icon on the 

toolbar in the confirmation dialog box, then click [Yes] to close the software. 

 
 

6 Equipment maintenance 

6.1 Routine maintenance 

(1) Dehumidification: Before use you must confirm there is no water or moisture on 

joint interface of cables. If there is moisture, it should be dried before use to avoid a short 

circuit after powering on. 

(2) Cover: After testing, safely put away all the parts (do not store cables in the sunlight). 

The plug should be covered. Using a dust cover for the machine is recommended. If 

used outdoors, the load bank should be covered up by a rainproof cloth to avoid 

corrosion and dampness. 

(3) Storage: The machine and accessories should ideally be stored in a cool, dry indoor 

environment, away from high temperature and damp environments. 

 
6.2 Regular maintenance 

(1) Maintenance time: It is recommended that the machine gets system maintenance 

checks after one year (according to the unit’s actual condition). If left idle for a long time, 

it is recommended to perform system maintenance before using. Reasonable regular 
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maintenance can prolong the service life of the machine and maintain good 

performance. 

(2) Cleaning: Operators should do thorough cleaning, especially the dust and debris that 

adhere to the vents which can be sweep out by brush or compressed air. Operators 

should be careful when cleaning to not open the enclosure. 

(3) Check: After cleaning, check carefully whether the equipment is in good condition. 

Turn on the power and check measuring instrument and that the fan is in good condition. 

If no abnormal issues then start the testing. 

(4) Ventilation: Operator should turn on the power to check the performance of the fan. 

If the cooling fan is abnormal or there is air duct blockage, it could cause the machine to 

overheat. 

(5) No-load running: If the machine is stored for a long time, it is recommended to first 

let the machine run without load, while not connected to the device under test. 

Components heat will disperse moisture to ensure that the device performance is stable 

and reliable. In areas where the air humidity is high, no-load running on a regular basis is 

an effective measure to reduce equipment failure. 

 
6.3 Troubleshooting 

Please see the below table for common issues and their possible solutions. If the 

problem you encountered is not listed here, please contact Eagle Eye Power Solutions, 

LLC for support. 

 

Problem Possible reasons Solutions 

The machine does not 

start 

Power supply is not 

connected 

Check the device wiring is correct, and check 

whether the local power supply is powered. 

Automatic shutdown after 

starting 
Power anomalies 

Check if the voltages of input working power supply 

is correct 

Abnormal fan rotation Power supply not steady Provide the steady power supply 

Lack of fan flow, poor 

heat 

dissipation 

Vents or fan blockage 
Check the vents and fan if there is debris, sweep 

out. 

Operation no response 
Control mode selection 

error 

Check that the control mode selection is in 

accordance with the current operation mode. 
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Switches not responding Switch is damaged 

If no response when you use some switches, the 

corresponding switch is damaged, please contact 

Eagle Eye 

Load switch cannot be 

opened, unloads 

immediately after 

loading 

Locked by emergency or 

automatic protection 

Check if the machine alarms, after the exclusion of 

a dangerous situation, rotate the emergency stop 

switch clockwise release to unlock. 

Power is 0 after loading 

Testing cables are not 

connected or equipment 

not started 

Check if the connection between load bank and 

equipment under test is OK. Make sure the 

equipment under test is online. 

Power cannot reach the 

set value 

Cable not firm or voltage 

problem 

Check if the cables are connected properly. Check 

if the voltage is in the normal range, if voltage is too 

low, power will be low accordingly 

Remote control has 

no response 

Data transmission line not 

firmly connected 

Re-connect data transmission line 

Can’t find testing data Data line not connected Re-connect data transmission line 

Software is not online 

Communication cable is not 

connected or incorrect 

communication interface 

settings 

Re-connect data transmission line, or changing the 

communication interface address settings. 

Contact Us 

Our support team is available for assistance if you have any questions or comments, 

please don’t hesitate to contact us. 

Phone: 1-877-805-3377 

Fax: 414-962-3660 

Email: info@eepowersolutions.com 

Website: www.eepowersolutions.com 

Mailing address: 

Eagle Eye Power Solutions, LLC 

6306 Eastwood Court 

Mequon, WI 53092 

mailto:info@eepowersolutions.com
https://eepowersolutions.com
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